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Common Issues 

Accessibility Errors 
Being aware of a few simple steps when creating your document or editing a current 
document will ensure you have an accessible document.  The following will outline the 
most common errors found within a PowerPoint, and the following lessons will go 
through step by step instruction on how to avoid these errors.  
 

Having images with no alternative text or identified as decorative 
 
Alt text (alternative text), also known as "alt attributes", "alt descriptions" are used to 
describe the appearance and function of an image 
on a page.  
 
Adding alternative text to photos is first and 
foremost a principle of web accessibility. Visually 
impaired users using screen readers will be read an 
alt attribute to understand an on-page image better. 
Alt tags will be displayed in place of an image if an 
image file cannot be loaded. 
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Text Contrast 

It's the difference between the darkness of your text and the lightness of your 
background. 
With dark themes, you may also have white text against a dark background. In that 
case, even more contrast is needed to maintain the same degree of legibility.  
In general, the more text stands out against its background, the easier it is to read. 

 

  

 
Tables without Headings 
 
Tables in documents are useful for communicating relationships between data, 
especially when those relationships can be best expressed in a matrix of rows and 
columns.  
Tables should not be used to control Layout. Authoring tools have other means of 
doing this, including organising content into columns. 
 
If your data is best presented in a table, try to keep 
the table simple. If the table is complex, consider 
whether you could divide it into multiple smaller 
tables with a heading above each. 
 
A key to making data tables accessible to screen 
reader users is to clearly identify column and row 
headers. Also, if there are nested columns or rows 
with multiple headings for each cell, screen readers 
need to be explicitly informed about which headers 
relate to which cells. 
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Slides without Headings 
 
Every slide should have a Title/Heading.  

 
Screen readers use these to replace a table of 
content to navigate the presentation.  
 
All slides automatically get this assigned when you 
add a new slide. But you may have deleted the title 
text box as you did not want text appearing on 
your slide. 
 
 
 
 
 

Reading Order 
 
As you add text/images/etc. to a slide, the reading order is also being defined.  
 
You may move things around on the slide to rearrange the layout in a logical visual 
way, but because you may have added an image before the title or some text before 
the title the reading order will not follow your visual layout.  
 
You should review the reading order for ALL slides and resort as required. 
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No language set 
 
Leading screen reader software is multilingual and can read content in English, 
Spanish, French, and a wide variety of other languages. In order to ensure that screen 
readers will read a document using the appropriate language profile, the language of 
the document must be identified. 
 
You should also identify the language of 
any content written in a language other 
than the document's default language. 
With this information, supporting screen 
readers will switch between language 
profiles as needed on the fly. 

 
Most document authoring tools provide a means of identifying the document 
language and the language of specific parts within the document. 
 
  

Locating the Accessibility checker 

 

In OFFICE 365 
 

1. You will find the 'Check accessibility' on the Review Tab. 
2. Clicking on this will open the  Accessibility Panel on the right of the screen.  
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This Panel will list any Errors the document may 
have.  
 
Clicking on any of the error or warning will 
activate an information panel on the lower 
section of the Accessibility Panel, which provides 
additional information on the error and steps on 
how to fix it. 
 
 
 
 

  

In older versions of Word: 

1. Click on File 
2. Click on Info  
3. Click Check for issues icon 
4. Select Check Accessibility 

OR 

1. Click on File 
2. Click on Options button 
3. You will need to check under the various menu to locate the Check 

Accessibility option as different version have this located in other areas. 
4. Select Check Accessibility 
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Why Alternative (Alt.) Text Description 

Presentation Images 
 
PowerPoint presentations rely on images to: 

• Replace large bodies of text with meaningful images. 
• They are used as triggers to expand on a topic or point. 
• Portray content such as tables in a more graphic format. 

Because of this reliance on images, especially in presentations with no embedded 
audio recording, it is essential to provide the supplementary information via the 
Alternative text/image descriptions. 
  
Some of the areas that cause issues when using images are: 

 

Example 1 

Issue:  
Text over images where the background and text colours don't have enough of colour 
contrast, so the text or part of the text is lost in the image. 
 
Fix:  

• Re-colour text to stand out 
• Move the text to a different part of the image where it can be clearly seen 
• Set the text box background to be a sold contrasting colour so the text can 

easily be seen. 
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Example 2 

 
Issue:  
Text is embedded in the image so a 
screen reader cannot read the text. 
 
Fix:  
Re-type the text into the alternative 
text description box 
 
 
 
 
 
  

Example 3 

Issue: 
Having a slide with only an image and no text. 
  
Fix:  
Provide a detailed explanation of the 
knowledge or understanding the student 
should have gotten from the image. 
 
 
 
 
 
 How to Write More Effective Alt Text 

Video - How to Write More Effective Alt Text 
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Adding Alternative (Alt.) Text Description 

Locating where to add a description. 
 
There is two way to add a description to an image 
quickly. 

 

Option 1 

1. Right-click on the image 
2. Scroll down the list to 'Edit Alt Text' 

 
 

 
 
 
 
 

 
 

 

Option 2 

1. Open the Accessibility Checker. 
2. Click on the Arrow beside the image 

listed under Errors. 
3. Click 'Add a Description' 
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Writing good ALT text description 
 
In some cases, providing poorly written ALT text description can be as bad as not 
providing ALT text at all. Poorly written, ambiguous, or irrelevant ALT text can actually 
worsen understanding of a page and cause confusion. 

  
Determining appropriate ALT text is often a matter of personal interpretation and is 
influenced by the image's context (i.e. the accompanying text). However, following the 
guidelines below will help you to create effective alternate text for most situations. 

  
ALT text should typically: 

• Be accurate and equivalent in presenting the same content and function as 
presented by the image. 
 

• Be succinct. This means the correct content and function of the image should 
be presented as succinctly as is appropriate. Typically, no more than a few 
words are necessary, though rarely a short sentence or two may be 
appropriate. 
 

• NOT be redundant or provide the exact same information as text within the 
context of the image. 
 

• NOT use the phrases "image of ..." or "graphic of ..." to describe the 
image. It's usually apparent to the user that it is an image. And if the image is 
conveying content, it is typically not necessary that the user knows that it is an 
image that is conveying the content, as opposed to text. 

The information in the bulleted list above is taken from WebAIM (April 2010). 
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When is Alt text description not needed? 
 
It is not always necessary or appropriate to add ALT text to images, such as in the 
following situations: 

• If an image is purely decorative and provides no useful information to the 
user to help them understand the web page's content. 
 

• If the information provided by the image is communicated effectively 
elsewhere in the body text of the page. Often images (or diagrams) are used 
to reinforce understanding and do not necessarily provide any additional 
information. Providing ALT text in this situation would duplicate text content. 

The information in the bulleted list above is taken from WebAIM (April 2010). 

  
 
 
 
 
Not needing an ALT description does not mean 
you do not need to put something in the 
description. Images that do not enhance or add to 
the information in the document's text should be 
tagged as DECORATIVE. 

  

Checking Contrast 

The colour required will depend on the background colour of the slide or image and 
the foreground text.  
 
The text could be over an image, shape, etc.  You will need to use the colour contrast 
analyser to select a better alternative to the font colour. But generally, with a light 
background you use a dark text colour and a dark background you will need a white 
or light coloured text.  
 
If it's an image of various colours, you will need to decide if there is anywhere on the 
image that is more suitable or it may require a solid shape behind the text over the 
image so the text can be easily read. 
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Fixing Text Contrast 
 
WCAG Level AAA requires a contrast ratio of 
at least 7:1 for normal text and 4.5 for large 
text. 
  
Large text is defined as 14 point and bold or 
larger, or 18 points (typically 24px) or larger. 
  
The Colour Contrast Analyser (CCA) helps 
you determine the legibility of text and 
contrast visual elements, such as graphical 
controls and visual indicators. This is a small 
app you download. 
  
WebAIM Contrast Checker is online. 
 
Contrast Finder - finds correct colour 
contrasts for web accessibility 
 
The colour required will depend on the 
background of the text. The text could be over an image, shape, etc.  You will need to 
use the colour contrast analyser to select a better alternative to the font colour. But 
generally, with a light background, you use a dark text colour and a date background 
you will need a white or light colour text. If it's an image of various colours, you will 
need to decide if there is anywhere on the image that is more suitable or it may 
require a solid shape behind the text over the image so the text can be easily read.   

 
Note: This warning does not go away. It's there as a reminder to check manually 
checked/review the reading order. 
 

Image Contrast 
 
The Colour Contrast Analyser (CCA) helps you determine if the text within images has 
enough contrast to be clearly read. 
 
If it does not you will need to either; 

• Edit the image in a software package like Photoshop  
• Find a better image. 
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Table Headings 

PowerPoint has limitations when it comes to making tables accessible. Tables can be 
very difficult for screen reader users to understand unless they include markup that 
explicitly defines the relationships between all the parts (e.g., headers and data cells).  
For a simple table with one row of column headers and no nested rows or columns, 
PowerPoint is up to the task.  
 
However, more complex tables can only be made accessible within HTML or 
Adobe PDF (accessible table markup can be added to the PDF using Adobe Acrobat 
Pro). 
 
Often complex tables can be simplified by breaking them into multiple simple tables 
with a heading above each. 

Step 1 
 

Identifying the Table Header 

For simple tables: the only step necessary for accessibility is to identify which row 
contains the column headers. When creating a table, two new tabs will appear in the 
ribbon.  
 

1. Click anywhere within the table.  
2. From the Ribbon menu, Table 

Tools select 'Design Tab'.  

 
 
Step 2 
 

Identifying the Table Header 

1. Selecting the Design tab 
will reveal the Table 
Styles Option group 

2. Tick to make the Header 
Row active.  
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NOTE 
If you have headings going down a column or across both a rows and columns, it is 
advisable to use one of PowerPoint's Table Styles templates the identity these as 
heading areas. The temple colours can be edited to suit your content.  
 
If you save this document to a PDF, you will need to run the accessibility checker to 
confirm the headings have been correctly tagged.  

 

  

 
Alternative (Alt.) Text Description 
 
If you need to use a complicated table or use merged cells, you should also add 
a description to the Alternative text. 

 
The description should explain the whole and provide a navigation review, such as 
column 1 / row 1, Column 1 / row 2, etc.  
The description should ensure the student would gain the knowledge and 
understanding that a sighted person would get from the table.  
 

Step 1 

1. Right-click anywhere within your active table.  
2. From the menu select "Format Shape".  This opens the Format Shape panel.  
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Step 2 

Click the Size & Properties icon (first icon on the 
right). This opens to provide more options. 
 
 

  

Step 3 

• Select Alt Text to expand this area. 
• Enter a Title and Description 

 

 

Slide Headings  

 

Why slide titles are important 
 
Why slide titles? 

• Accessibility  - A visually impaired person, who uses a screen reader relies on 
the slide titles to know which slide to select. 

• Helping various PowerPoint features work correctly - Design Ideas, Apply 
Layout and Reset Slide work better on slides with titles. Insert Hyperlink, Insert 
Zoom, and custom shows all refer to slides by their titles. 

 
There are multiple ways to add titles to your slides in PowerPoint.  

• Use the Accessibility Checker 
• You can also use the Outline view to create and update the titles of your slides. 
• Use the Layout option to create a standalone title slide or to add a title to a slide 

that contains other text.  
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 - Office 365 
You will find the 'Check accessibility' on the Review Tab. 
  

 
 
 
Clicking on this will open a new panel on the screen's right where any Errors in the 
document will be highlighted. Clicking on the error or warning will also active 
information on what the error means and how to fix it. 
 

Accessibility Checker can point out four situations where a title is warranted:  

 
Option Description 

Edit Slide Title Appears if the slide already has a title placeholder and you 
just need to fill it in. 

Add Slide Title 

Appears when a slide doesn't have a title placeholder.  
Choosing this option adds a title placeholder even if the Slide 
Layout you used didn't have one.  Fill it in with the title you 
want to use. 

Add Hidden Slide 
Title 

Appears if the slide already has a title placeholder and you 
just need to fill it in. The placeholder is positioned off the 
slide so that it's invisible during Slide Shows and in printouts. 

Set as Slide Title 

Appears when the slide has no title placeholder. When you 
choose this command, PowerPoint automatically selects 
what it thinks is the most likely text box to be the title. But 
you can change the selection if necessary. 

 
Unique Slide Titles 
 
You will get a 'Tip' that there are two or more slides with the same slide title. 

• This is an issue for screen reader as they use the titles of the slides like chapters 
in a book.  
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• Having one or more chapter title the same would confuse someone trying to 
navigate the presentation, especially if the duplicate titles are in separate areas 
of the presentation.  

 
If you have to have the titles the same, please use extensions like Part 1, part 2..., or 
title Cont., etc.  

 

  

 

 

Fix Slides  Headings - Accessibility Checker 

Step 1 
Accessibility Checker 

 - Office 365 
 

• Click the Check Accessibility icon to open 
the Panel, 

 
 

  

Step 2 

• Click on the Arrow beside 'Missing slide title' 
to see the list of slides missing titles. 

 
 

 



 

Page 19 of 27 

 
 

• Clicking on any of the listed slides 
will change the left hand panned 
to Outline View 

 
 

 
 
  

Step 3 
 
Click on the Arrow at the end of the listed slide to see 
options: 

• Add slide title 
• Add Hidden slide title 

 

Add slide title 

• Clicking 'Add slide title' will place a title text box on the slide. 
• Enter/format text as normal to the title text box. 

 
 

Add Hidden slide title 

• Clicking 'Add Hidden slide title' will place a title text box above the slide. 
• Enter/format text as normal to the title text box. 
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NOTE: This is hiding the title from displaying on the screen, not from the screen 
reader. See Reading Oder for steps to hide the on-screen title from being read by the 
screen reader. 

 
 
 

Fix Slides  Headings - Outline View 

Step 1 
 

OUTLINE VIEW 

• Click on the View Tab  
• Click on Outline View 

 

 

 
 

Step 2 

• Scroll down the slides list in the Panel till you come 
to a slide number with no text 
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Step 3 

• Start typing into the 
empty slide title area on the 
Panel. 

• As you type the text you are 
typing will appear on the 
slide. 

 
 

Step 4 
Removing a title from a presentation slide.  
 

• Click and drag the title text box off the slide. 

NOTE: This is hiding the title from displaying on the 
screen, not from the screen reader. See Reading Oder 
for steps to hide the on-screen title from being read by 
the screen reader. 

 
  

Recommended Styles 

 
The University brand preferred fonts are Gotham Narrow Light for Heading 
and Chronicle for the body of the text.  
 
These are the university custom fonts. 
 
If they are not your home computer,  the preferred alternative is Open Sana which is 
available on all computers.  
 
Please use the preferred fonts if they are available to you.  
 
 
The following are suggested Styles to keep consistency across the university.  
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Title Slide - Crimson background 
Main Heading 

Font: Gotham Narrow Light  - (replace with Open Sans if this font is not your 
computer) 
Font size: 54pt 
Colour: White    Hex #FFFFFF  /  RGB 255-255-255 
 

Title Slide - Crimson background 
Sub-Heading 

Font: Gotham Narrow Light  - (replace with Open Sans if this font is not your 
computer) 
Font size: 48pt 
Colour: White    Hex #FFFFFF  /  RGB 255-255-255 
 

Section Title Slide - Crimson background 
Main Heading 

Font: Gotham Narrow Light  - (replace with Open Sans if this font is not your 
computer) 
Font size: 30pt 
Colour: White    Hex #FFFFFF  /  RGB 255-255-255 
 

Section Title Slide - Crimson background 
Sub-Heading 

Font: Gotham Narrow Light  - (replace with Open Sans if this font is not your 
computer) 
Font size: 21pt 
Colour: White    Hex #FFFFFF  /  RGB 255-255-255 
 

Standard Slide - Crimson top banner 
Banner title 

Font: Gotham Narrow Light  - (replace with Open Sans if this font is not your 
computer) 
Font size: 24pt 
Colour: White    Hex #FFFFFF  /  RGB 255-255-255 
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Standard Slide - White top banner 
Banner title 

Font: Gotham Narrow Light  - (replace with Open Sans if this font is not your 
computer) 
Font size: 24pt 
Colour: Crimson     Hex #990033  /  RGB 153-0–51 
 

First Level Text (Body) 
Font: Chronicle  - (replace with Open Sans if this font is not your computer) 
Font size: 24pt 
Colour: Dark Grey    Hex  #3A3537   /  RGB 58-53–55 
 

Text Emphasis 
Font: Chronicle  - (replace with Open Sans if this font is not your computer) 
Font size: 24pt 
BOLD 
Colour: Black   Hex #000000  /  RGB 0-0–0 
 

Second Level Text 
Font: Chronicle  - (replace with Open Sans if this font is not your computer) 
Font size: 21pt 
Colour: Dark Grey    Hex  #3A3537   /  RGB 58-53–55 

Third Level Text 
Font: Chronicle  - (replace with Open Sans if this font is not your computer) 
Font size: 18pt 
Colour: Dark Grey    Hex  #3A3537   /  RGB 58-53–55 
 

Fourth Level Text 
Font: Chronicle  - (replace with Open Sans if this font is not your computer) 
Font size: 15pt 
Colour: Dark Grey    Hex  #3A3537   /  RGB 58-53–55 
 

Link Text 
Font: Gotham Narrow Light  - (replace with Open Sans if this font is not your 
computer) 
Font size: 24pt 
Colour: Crimson     Hex #990033  /  RGB 153-0–51 
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Check Reading Order 

Must Check 
As you add text/images/etc. to a slide, the reading order is also being defined.  
 
You may move things around on the slide to rearrange the Layout in a logical visual 
way, but because you may have added an image before the title or some text before 
the title. The reading order will not follow your visual Layout.  
 
You should review the reading order for ALL slides and resort as required. 
 
There are two ways to access the Reading Order. 

Selection Pane 

1. From the Home Tab. 
2. Click on the Arrow beside Select. 
3. Click on Selection Pane 

 
 

 
Accessibility Checker 

1. Open the Accessibility 
Checker. 

2. Under Warning / Click on the 
arrow to expand Check 
reading order 

3. Click on the arrow beside the 
slide and select Verify Object 
Order 

 
Note: The checker may only list a couple of slides for review, but you will need 
to check all slides in your presentation. 
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Reorder Slide Items 

1. Hold your mouse down on the 
object you wish to move 
and drag to the correct position 
for the correct reading order. 

2. Click on the next 
slide and repeat the reordering.  

3. Keep repeating till the whole 
presentation has been checked.  

 

 
Hiding on Screen Slide Title from Screen Reader 
 
If you do not wish the title read out by the screen reader,  you can hide the title in 
the Selection pane by clicking on the icon beside the title. This will put a line through 
the icon indicating it will not be readout.  
 
NOTE: The slide title will not be 
affected when a screen reader as 
scrolling through the slides. 
 
 
 
 
 
 

Setting The Language 

Set Language 
 
This should be one of the last steps in developing your presentation to ensure all 
text that has been copied into the presentation is using the correct language. 
 
English Australia dictionary should be used for all presentations.  
 
PowerPoint originally defaults to English (United States) when installed. 
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Even having the language permanently set as the default, in Microsoft Welcome to 

PowerPoint.potx template file, you will still need to check the content's language if 
you have copied any text in from another document or the internet. 
 
You will also need to define any other languages you have within the document. 
 

 

  

Set Proofing Language - not available. 

1.  On the Review tab,  click 
on Language 

2. Click on Set Proofing Language 
3. If the Set Proofing Language is not 

available (greyed out), it means that 
no slides have been selected. 

 

 
 

Step 1 

1. Click on the View tab and select Outline View 
2. Select ALL the slides 

 
 
Note: Clicking on one slide will only set the language 
for that slide. 
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Step 2 

• On the Review tab,  click 
on Language 

• Click on Set Proofing Language 

 

 

 
 

Step 3 

• Make sure English (Australia) is 
selected 

• Click Set As Default 
• Click OK 
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